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1 ORTIMnotes-sp

The program ORTIMnotes-sp is used for entering notations, which can be
subsequently imported and evaluated by the ORTIMnotes software.
There are two possible ways of using the  ORTIMnotes-sp program:

Self-notation on the PC

ORTIMnotes-sp runs in the background on the computer. The times for the notations
are calculated by the program. Once the next time for a notation is reached, the
program alerts the user to the pending notation, which can then be entered in a
screen mask.

Entry from notation cards

The times for the notations are determined by the signal generator, the cards are
filled out by hand. They are then entered into the computer with ORTIMnotes-sp.

1.1 Self-notation on the PC

Start project

On launching the program for the first time, you need to specify the notation task you
wish to work with.
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Import notation task from ORTIMnotes

To use a notation task supplied from ORTIMnotes, you select this from the file
selection dialog: 
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Here, you set the directory containing the notation tasks exported from ORTIMnotes.
Proceed by selecting the file whose name corresponds to your reference number.
(Further details on this can be obtained from the person responsible for conducting
the project). 

The central project directory you select here is subsequently also used for storing the
notations you record.

Use printed out notation task

If you have received a printed notation task, enter the number of the task and the date
from which the task is valid. You also need to specify the "notation cycle". 

The notation cycle defines the average interval in minutes between two notations. The
value can be between 1 minute and 99 minutes. The default is 60 minutes. You can
change the notation cycle during the course of the project (menu "Settings – Notation
task"). A modified cycle takes effect from the following project day.

Notation signal

This tab allows you to specify how the program is to respond on reaching the next
time for a notation. It is possible to change this setting while the project is in progress
(menu "Settings – Notation signal").
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Program start

Once you have configured the project, the notation module is started automatically. In
addition, it is also entered in the startup folder of the Windows Start menu.
Consequently, until the project is concluded, the notation module will be initialized
each time the computer is started. 

Normally, the program window is not visible. Only an icon appears in the taskbar.
Left-clicking with the mouse on the icon allows you to open the program window at
any time. Closing the program window does not exit the notation module, which
appears instead in the task bar. If you really want to exit the notation module, you
need to execute the command "Exit" from the "File" menu.
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Enter notation

Enter notation

When the time for a notation comes round, depending on the settings, the program
window is opened either automatically or is activated by clicking on the flashing
program icon in the system tray.

The correct functioning of this setting is only ensured by setting the behavior 
Show icon and notifications for the system tray icon of ORTIMnotes-sp.

The table contains a new line with blank entry fields. The first column displays the
time; the other columns are used for entering the notation. To do this, use the
numbers and IDs of the printed notation task. 
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It is possible to change the column headers in the "Texts" settings page in order to
adapt to the designations used in the project. If, at the time of the notation, you are not
at your workstation, you can enter the notation later.

Enter the respective data in the cells of the table. Select <Enter> or <Tab> to move to
the next cell. If you press <Enter> again in the last cell, the window is closed
automatically (if this has been set to do so, see above). The field "Remarks" provides
space for entering any explanations. The key combination <Alt+Enter> toggles the
cursor between the table and the text field.

Edit earlier notations

The entry located immediately before the notation currently expected is the only one
that still be edited; all the earlier notations are locked against changes and appear
grayed out. If changes are still necessary here, enter these as text in the "Remarks"
field. Once imported into ORTIMnotes, these remarks can then be taken into account.

Hide columns that are not required

Depending on the complexity of the notation task, you might not need to use all the
columns of the table. The "View" menu allows you to hide individual columns: Click on
the column name to show and/or hide the column. 
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It is not possible to deactivate the columns for "Time" and "Task No.".

End of the working day

If the computer is switched off at the end of the working day, the program will
automatically resume with a new, blank table on the next day when the computer is
started.

If the computer is not switched off at the end of the working day, signals for self-
notation will still be triggered and blank entry lines generated. If no further notations
are made by the end of the day, these will be deleted. In this case, the following
message will appear:

The time of confirming this message is also the starting time for the self-notation on
the next day.

Using a notation task

Enter notation

If ORTIMnotes-sp is used with a notation task exported from ORTIMnotes, the input
screen for the notation participant will look as follows:
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If you know the input value, you can enter this in the box provided for this. The value is
subsequently checked against the notation task. If it is valid, it will be augmented with
the associated long text (except for the influences). If it is invalid, the box will be
emptied. 

If you wish to select a value from the list of possible options defined in the notation
task, tap on the +-button after the respective input box. A selection window will
appear. 

Selection features do not have a menu item on account of the fact that they do not
already have to be contained in the project and, consequently, nor in the notation
task, either. The values are entered manually in this case. During the import into the
project, these values will then be created if they do not already exist.

Select the value you require and confirm your selection with OK to transfer this value
into the notation field. 

The selection window for influences allows you to highlight and transfer multiple
values.
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Saving the recorded data

All the notations entered are saved in the personal application data directory of each
workstation.

On the "Project directory" settings page, you can specify whether and where the
recorded notations are also to be copied to every day:
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This option is set as the default in the following cases: 

· The notation task has been imported from ORTIMnotes (see above)

· If the self-notation program has been started on a network drive.

If you check the option for Names for notation files assigned user ID and computer
name , these files will also be assigned the user’s login name and the name of the
computer in addition to the participant number.

Conclude project

Once a project has been completed, it should be "concluded": You do this by
selecting menu option "File – Conclude project".

If you are using a central project directory (see above), the notations are automatically
saved in this directory of ORTIMnotes.

Otherwise, when concluding the project, you need to specify where the entered data
are to be saved to. You can specify a random directory; however it is advisable not to
change the suggested file name.

Das Notierungsprogramm wird anschließend aus dem Autostart-Ordner des
Startmenüs entfernt. Die lokal gespeicherten Daten werden gelöscht. Eine
Sicherungskopie mit dem Namen _notierungen.noti.xxx (xxx steht für eine laufende
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Nummer) bleibt aber erhalten und muss ggf. manuell aus dem persönlichen
Anwendungsdatenverzeichnis des Benutzers entfernt werden.

1.2 Entry from notation cards

The program window replicates a notation card. An additional field is available for
entering remarks.

Prior to starting an entry, you should adjust the size of the window such that the
header data and all the notation rows you require are visible. This window size is
automatically saved and re-used each time the window is subsequently re-opened.
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Enter header data

First of all, the header data of a notation card have to be entered:

Proceed as follows when entering the header data:

· Enter the date of the notation card (the current date is defaulted after opening the
notation window) and select TAB or ENTER to move to the next field.

· Enter the time of the notation card and select TAB or ENTER to move to the next
field.

(See below for details on entering the date and time).

· Enter the notation cycle. Normally, the field contains the correct value by default and
can simply be skipped with TAB or ENTER.

Enter the reference number ("Task No.") and confirm the header data with ENTER.

If the entry fields for the header data are error-free, the cursor is positioned in the
table. Otherwise the field with errors is highlighted red and has to be corrected.

If a card for the reference number already exists for the specified date, this will be
displayed. Selecting "Reset" releases the entry screen.

Entering the date

The date entry field allows you to enter a date in numerous ways. For instance, it can
be entered quite "normally" – with or without left-hand zeros, with or without the year –
into the field: "3.2.00". Further options for user control are:

Arrow left, right

Changes between day, month, year (likewise the comma key on the numeric keypad
and the keys , . : - /).

Arrow up, down

Increases and/or diminishes day, month or year (likewise the plus and minus keys on
the numeric keypad).

Home, End

Set the lowest and/or highest possible value for day, month or year.



ORTIMnotes-spPage 16

Ctrl+Home

Displays the current date in the entry field.

Alt+down arrow

Opens the calendar. (Alternative method: Click on the button next to the entry field).

Using the calendar

Click on:

a day

Sets the day, closes the calendar and imports the set date into the entry field.

"Today"

Closes the calendar and imports the current date into the entry field.

Arrows left/right

Switches to the same day in the preceding or following month.

The name of the month

Displays a menu with all the names of the months.

The year

Allows you to change the year.

Arrow left, right

Switches to the preceding or following day (also from one month to the next).

Arrow up, down

Switches to the same week day of the preceding or following week (also from one
month to the next).

Home, End

Switches to the first and/or last day of the month.

Page Up, Page Down

Switches to the same day in the preceding or following month.
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Ctrl+Page Up/Down

Switches to the same day in the preceding or following year.

Enter

Closes the calendar and transfers the set date into the entry field.

Esc

Closes the calendar and restores the earlier contents of the entry field.

Entry of the time

It is possible to enter the time directly in the form "07:30" – with or without left-hand
zeros – into the entry field. Further options for user control:

Arrow left, right

Switches between hour and minute (likewise the comma key on the numeric keypad
and the keys, . : - /).

Arrow down, up

Increases and/or diminishes the hour or minute (likewise the plus and minus keys on
the numeric keypad or by clicking on the arrows next to the entry field).

Home, End

Sets the lowest and/or highest possible value for minute or hour.

Enter notations

Now transfer the individual notations from the card into the table. You can deactivate
individual columns of the table, which are then automatically skipped during entry. 

Use ENTER to move from one cell of the table to the next cell. In addition, you can
use TAB and Shift+TAB as well as the arrow keys to move between the cells.

To overwrite a value in a table cell with a different value, select the cell and simply
enter the new value. To edit a value, you need to activate the cell with a double-click
or with Ctrl+ENTER.

The individual columns of the notation card are entered as follows into the screen
form:

Task: Transfer the task number from the current row of the card.

Activity: Transfer the activity ID from the current row of the card. You can enter the ID
without the Shift key.
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Qualitative influences (checked): For each checkmark, you type in the number of the
corresponding column. If for example the columns 1, 4 and 6 are checked, you write
"146". 

Cost unit: Transfer the cost unit number from the current row of the card.

Key combination Alt+ENTER allows you to toggle back and forth from the table to the
"Remarks" field.

Saving the recorded data

Once the notation card has been fully transferred, it is advisable to at least check
whether the number of notation rows on the card corresponds to the number on the
screen.

You can then save the card (button or key combination Ctrl+S). If the card has been
accepted without errors, all the entry fields will automatically be deleted, and the
window released for entry of the next card.

Project directory

All the entered notations are saved in the personal application data directory of each
workstation.

The "Project directory" settings page allows you to specify whether and where the
recorded notations are also to be written to:
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If this auto-save function is not enabled, recorded data have to be saved in a random
directory at the end of the project by selecting the command "Save as..." from the File
menu.

Conclude project

Once a project has been completed, it should be "concluded": You do this by
selecting menu option "File – Conclude project".

If you are using a central project directory (see above), the notations are automatically
saved in this directory of ORTIMnotes.

Otherwise, when concluding the project, you need to specify where the entered data
are to be saved to. You can specify a random directory; however it is advisable not to
change the suggested file name.

The locally saved data are subsequently deleted. A backup copy with the name 
_karten.noti.xxx  (xxx is a serial number) is however retained and, if necessary, has to
be removed manually  from the user's personal application data directory.
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1.3 Annex

Updates

The software update function integrated in ORTIMnotes-sp is capable of downloading
updates from the Internet and linking these to the program. The function is accessed
via menu option Check for updates...  in the Help menu.

The Internet is accessed via the Windows Internet settings.

Languages

ORTIMnotes-sp comprises the program languages Deutsch  (German) and English.
The program language is changed via the Language  menu option in the Settings
menu.
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System administration

The system administration section contains information about the ORTIMnotes-sp
program and the operating system. The system administration section is accessed
via the "Tools" menu.

Directories and files

Program directory

This is the directory in which the ORTIMnotes-sp program has been installed. 

The logged in Windows user must have read and execution rights. Following the
installation, there are no further write accesses to this directory.

Application data directory

The ORTIM subdirectory of the personal application data directory associated with
the logged in user is used for storing data. It is displayed in the system administration
section under "Directories – Application data".

It is necessary for the logged in Windows user to have full access rights in this
directory.

The following files are stored in this directory (xxx stands for a serial number between
000 and 999):
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_auftrag.noti

The notation task of the self-notation program.

_notierungen.noti

The data storage location of the self-notation program.

_notierungen.noti.xxx

The backup copy of the self-notation data after project conclusion.

_karten.noti

The data storage location of the card entry program.

_karten.noti.xxx

The backup copy of the card entry data after project conclusion.

Onotessp.log

The log file of the self-notation program.

Onotesspk.log

The log file of the card entry program.

The files Onotessp.ini and Onotesspk.ini from earlier program versions are no longer
used. The local settings are saved in the Windows registry.

Central project directory

The use of a central project directory in the network is optional. 

When installing ORTIMnotes-sp in a network, the 'Data' subdirectory of the program
directory is configured as the default for a central project directory. 

This project directory is used for storing the entered notations – in addition to being
saved in the local application data directory – at the end of each project day. In
addition, the notations are copied into this directory on conclusion of the project.

The project directory can contain the following files (xxxxx stands for the five-digit
number of the notation task, ccccc for the computer name):

Axxxxx.a

The notation tasks exported from ORTIMnotes.
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Axxxxx.aa

Copies of the notation tasks already used; the presence of such a file indicates that
the corresponding task is already in use.

Nxxxxx.n

The notations saved at the end of each day and on conclusion of the project.

Nxxxxx.nn

The backup copies of the notations already imported into ORTIMnotes.

Karten-ccccc.k

The notations saved on exiting the card entry program.

Karten-ccccc.kk

The backup copies of the notations from the card entry already imported into
ORTIMnotes.

OnotesImport.log

The log of the last import into ORTIMnotes.

The logged in Windows user requires full access rights for this directory.

Command line

The command line allows you to execute the Onotessp.exe program file directly and
to transfer parameters at the same time that influence the behavior of the program. 

You can enter the command line in a command line window ("prompt") or define it as
the destination of a link, for example:



ORTIMnotes-spPage 24

/diag

This option allows you to perform a diagnosis of possible problems. The result of the
diagnosis is displayed in a window from which you can save the diagnosis file or
send it as an e-mail. The ORTIMnotes-sp program is not launched.

/log

With this option, a window is opened from which you can save the log file of the
program or send it as an e-mail. The ORTIMnotes-sp program is not launched.
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